Diary Mode� XE "Diary Mode" �  �



�



Diary Mode



The Diary Mode is used to keep appointments, task lists (to-do lists) and background activities for yourself and all the other users in your organisation.



From within the Diary Mode you can view and update your own diary information. If you have the necessary access rights, you can view and even update other users’ diary information. OfficeTalk also lets you keep diary information for resources such as meeting rooms, pool cars and other bookable objects.



When you log on to OfficeTalk for the first time, you will, by default, enter the Diary Mode. There are two main windows in this view; the Appointments Window and the Task List. The information from both windows is collectively called your diary. You may view another user’s diary, or the diary of a resource, by selecting the user, or resource, from the Diary pull down list which is located at the top of the Diary Mode window. This gives very quick access to a lot of shared scheduling information. 



Provided that you have sufficient access rights, you may add or change information in other user’s diaries as if they were your own. The rest of this chapter explains how you can use the features of the Diary Mode.



� XE "Appointment" \t "See Daily Appointment" �� XE "Appointment" �Daily Appointments Window� XE "Daily Appointments Window" �   �



The Daily Appointments Window is set at the left of the Diary Mode. It shows a user’s or resource’s appointments for a particular day. The window contains a series of time slots with the time of day being displayed down the left margin.



� EMBED PBrush  ���



Daily Appointments Window





C� XE "Appointment:Changing the Timescale" �hanging the Timescale� XE "Changing the Timescale" �



OfficeTalk lets you choose a timescale for the Daily Appointments Window from any one of the following scales:



	5 Minutes per timeslot

	10 Minutes per timeslot

	15 Minutes per timeslot

	30 Minutes per timeslot



To change the timescales displayed, use the � and � buttons above the Daily Appointments Window. Pressing the � button will zoom in to give a finer scale with a maximum scale of 5 minutes per timeslot. Pressing the � button will zoom out to give a coarser scale with a minimum scale of 30 minutes per timeslot. 



The Daily Appointments Window is capable of showing appointments as short as 5 minutes in duration regardless of the scale shown. If, for example, you have chosen a timescale of 30 minutes per timeslot, yet you have an appointment at 11:05am lasting 5 minutes, then OfficeTalk will show this by adding another timeslot to represent your appointment:



�



Adding a 5 minute appointment to a 30 minute timescale





A� XE "Appointment:Adding an Appointment" �dding an Appointment� XE "Adding an Appointment" �



You may add an appointment to the Daily Appointments Window very easily by clicking the mouse, using the left mouse button, in a time slot, typing the appointment description and pressing RETURN. There are other ways of adding an appointment. These are detailed below:



Action�Description��Click the mouse in the relevant time slot.�A dotted outline will appear around the time slot. Type in the description of the appointment and press ENTER.��Double-click the mouse in the relevant time slot.�An Appointment dialog box will appear. Fill out the details and press OK.��Click the mouse in the relevant time slot and press ENTER.�An Appointment dialog box will appear. Fill out the details and press OK.��Press the � button above the Appointments Window.�An Appointment dialog box will appear. Fill out the details and press OK.��Press the � button located in the sub toolbar.�An Appointment dialog box will appear. Fill out the details and press OK.��Press the right mouse button to bring up the popup menu and select New Appointment.�An Appointment dialog box will appear. Fill out the details and press OK.��Organising a meeting.�If you organise a meeting in Meeting Mode, OfficeTalk will place a tentative appointment in your diary. See the Meeting Mode chapter.��Drag a task to an Appointment Window.�Drop a task on the relevant time slot. See Task List in this chapter.��Drag a task to the calendar.�Drop a task on the relevant date on the Calendar. OfficeTalk will try to schedule the task as early in the day as possible.��

Some of the ways of adding an appointment will bring up an Appointment dialog box. 



�



Appointment dialog box



The fields of the Appointment dialog box are described in the table below:



Field�Description��Description�The description of the appointment.��Time�The date and time when the appointment starts.��Duration�How long the appointment will take. The duration is rounded to the nearest 5 minutes. The duration is be specified in terms of hours and minutes. For example: 1h30m would represent 1 hour and thirty minutes.��Remind�Check this check box if you wish to be reminded prior to the start of the appointment. Unless you specify a remind time, OfficeTalk will remind you, by default, 5 minutes before the appointment is due to start. You may change this default of 5 minutes by changing the Default Remind Time field in the General Preferences dialog box available via the Options menu. Note that OfficeTalk will only remind you of appointments occurring on the current day.��Remind Time�The number of minutes before the appointment that you wish to be reminded.��Private�Check this check box if you do not want other users to see the description, details or notes of the appointment. This applies even to other users who have full access to your diary.��

If you want to add, for example, a 5 minute appointment, then press the � button until the Daily Appointments Window represents a timescale of 5 minutes per timeslot. Then click the mouse in the relevant timeslot (using the left mouse button) and type in the booking.





E� XE "Appointment:Editing an Appointment" �� XE "Editing An Appointment" �diting An Appointment



There are four ways to edit an appointment from the Daily Appointment Window. These are as follows:



Action�Description��Double-click the mouse on the relevant appointment.�An Appointment dialog box will appear. Modify the details and press OK.��Click the on the relevant appointment and press ENTER.�An Appointment dialog box will appear. Modify the details and press OK.��Click the on the relevant appointment and start typing.�OfficeTalk will allow you to modify the description of the appointment without you having to pop up the Appointment dialog box.��Press the � button above the Appointments Window.�An Appointment dialog box will appear. Modify the details and press OK.��



C� XE "Appointment:Changing an Appointment's Duration" �hanging an Appointment’s Duration� XE "Changing an Appointment's Duration" �



There are two ways to change an appointment’s duration:



Œ The first way is by bringing up the Appointment dialog box. Select the relevant appointment in the Daily Appointments window and press the � button at the top of the window. The Appointment dialog box will appear. Modify the duration field as necessary. The duration must be specified in terms of hours and minutes. For example: 1h30m would represent 1 hour and thirty minutes. The duration of an appointment is always rounded to the nearest 5 minutes.



� A quicker way to change an appointment’s duration is to stretch the appointment using the duration bars down the left side of the Daily Appointments Window. To change the duration of the appointment but fix the start time, you must drag the duration bars from the bottom-most part of the bar.





�



Changing the duration of an appointment



To change the duration of the appointment but make the start time earlier, you must drag the duration bars from the uppermost part of the bar. 



Note:	Appointments may not be longer than 1 day in duration.





M� XE "Appointment:Maximising" �aximising the Daily Appointments Window� XE "Maximising the Daily Appointments Window" �



You can maximise the the Daily Appointments Window by pressing the � button in the top right corner of the Daily Appointments Window. When maximised, the button in the top right corner of the window will change to a � button. Press this button to restore the window to its original size. When the Daily Appointments Window is maximised, pressing the UP and DOWN keys on the keyboard will change the diary being viewed.





M� XE "Appointment:Moving" �oving an Appointment� XE "Moving an Appointment" �



You can move an appointment by dragging it from its current time slot to another time slot. The appointment will start from the time slot that you drag it to and will keep its duration. You can move an appointment to another date in the following way:



Œ Select the relevant appointment in the Daily Appointments Window and press the � button at the top of the window. The Appointment dialog box will appear. 



� Modify the date in the Time field and press OK.



A quicker way to change the date of an appointment is to drag the appointment to the relevant day on the calendar. OfficeTalk will attempt to make the appointment at the same time on the chosen day. However, this way restricts you to moving an appointment within the same month.



� EMBED PBrush  ���



Moving an appointment using the calendar





D� XE "Appointment:Deleting" �eleting an Appointment� XE "Deleting an Appointment" � 



Usually when you have completed an appointment you will want to keep the appointment in your diary as a record of what you have done. Sometimes, though, you may wish to delete an appointment. You can bin an appointment in one of three ways:



Œ The first way is by dragging the appointment from the Daily Appointments Window to the bin.



� EMBED PBrush  ���

The Bin



� Another way to bin an appointment is by selecting the appointment and pressing the DELTE key on the keyboard.



(	Yet another way is by selecting the appointment and pressing the � button.



You can retrieve an appointment that has been binned by double clicking on the bin. This will bring up the Bin Contents dialog box from which you can unbin the appointment. You can delete the appointment completely by shredding the appointment from within the Bin Contents dialog box. For more information on binning, un-binning, and shredding, see The Bin section in the General OfficeTalk Features chapter.



A repeated appointment is one which has been created by repeating another appointment using the Repeat Appointment command in the Schedule menu. For more information on this, see Repeating Appointments later in this chapter. If the appointment that you want to bin is a repeated appointment, then OfficeTalk handles this in a slightly different way. When you attempt to bin a repeated appointment, OfficeTalk will pop up a Bin Repeated Appointments dialog box.



�



Bin Repeated Appointments dialog box



You have the following choice:



Bin this appointment only

Bin this appointment and all before in the same repeat sequence

Bin this appointment and all after in the same repeat sequence

Bin all appointments in the same repeat sequence



Select the appropriate radio button and press OK. OfficeTalk will bin this appointment and other appointments according to your selection.





R� XE "Appointment:Reminding" �eminding yourself about an appointment� XE "Reminding yourself about an appointment" �



There are two ways to add a reminder to an appointment:



Œ The first way is to select the appointment from the Daily Appointments Window and press the � button. This will pop up the Appointment dialog box. Check the Remind check box and specify the number of minutes fore-warning that you require.



�



Appointment dialog box



� Another way is to select the appointment and press the � button above the Daily Appointments Window. This will add a reminder to the appointment. You will be reminded 5 minutes before the appointment is due to start. You may change the default advance remind time from 5 minutes to a time of your choice by modifying the Default Remind Time field in the Preferences dialog box available by selecting General Preferences in the Options menu.



�



Preferences dialog box



In both cases, a � symbol will appear on the appointment to indicate that a reminder is attached to this appointment. 



When the time comes, OfficeTalk will remind you of the appointment by popping up a message box to the screen. Press OK to remove the reminder. The � symbol will be removed.



�



Reminder message box



Note:	OfficeTalk will only remind you of appointments on the day that they are booked.



M� XE "Appointment:Private" �arking an Appointment as Private� XE "Marking an Appointment as Private" �



Any user which has at least read access to your diary may view your appointments. You may have an appointment that you do not want other users to know about, yet you may wish to indicate your non-availability at this time. OfficeTalk lets you mark a particular appointment as private to you. You can do this in the following way: 



	Œ 	Select the appointment from the Daily Appointments Window.

�		Press the � button. This will bring up the Appointment dialog box. 

Ž	Check the Private check box and press OK.



All other users will see this appointment’s description as PRIVATE, including users who have full access to your diary.





A� XE "Appointment:Notes" �dding Notes to an Appointment� XE "Adding Notes to an Appointment" �



You may add a note to any appointment. You can do this in the following way:



Œ	Select the appointment from the Daily Appointments Window.

�	Press the � button. This will bring up the Appointment Notes dialog box into which you can type any free format text or paste text from the clipboard or another Windows™ package.

Ž	Press OK.



A � marker will appear on the appointment.



Another way of bringing up the Appointment Notes dialog box is by pressing the � button from within the Appointment dialog box or by double clicking (using the left mouse button) on the � symbol, which will be visible if the appointment already has notes.





D� XE "Appointment:Deleting Notes" �eleting Notes from an Appointment� XE "Deleting Notes from an Appointment" �



You may delete appointment notes by selecting the appointment and choosing Delete Notes from the Edit/Appointment menu.



� EMBED PBrush  ���



Delete appointment notes



OfficeTalk will confirm that you wish to delete the selected appointment’s notes. Press Yes to confirm.



�



OfficeTalk confirmation



Changing the Day Shown� XE "Changing the Day Shown" �



There are several ways of changing the date in the Daily Appointments Window. If you change the date of the calendar then the Daily Appointments Window will show appointments on the selected date. The � (Previous Day), � (Today) and � (Next Day) buttons may also be used to change the date shown in the Daily Appointments Window. You can also use the Date menu:



� EMBED PBrush  ���



The Date Menu



Selecting Previous or Next from the Date menu will change the date of the Daily Appointments Window to the previous day or the next day respectively. The same menu command may be used when viewing the Weekly Appointments Window and the Monthly Appointments Window to change the date to the previous or next week or month respectively. (See the Weekly Appointments Window and the Monthly Appointments Window later in this chapter). Selecting Today will set the Daily Appointments Window to display the current day’s appointments. If you select the Edit Date menu item, a Date dialog box will appear. Type in the date that you wish to show in the Daily Appointments Window, using the format dd/mm/yy, and press OK. The Daily Appointments Window will display the chosen date.



�



Date dialog box





Exporting Appointments



OfficeTalk lets you export appointments to a CSV file. You can do this in the following way.



(	Select Export/CSV Appointments from the File menu. This will pop up a CSV Output dialog box.



�



CSV Output dialog box



�	Select a filename for the output CSV file. You can do this by pressing the � button and selecting the filename from the Save As dialog box.

	

Ž	If you want each item of data to be encapsulated by quotes, then ensure that the Quoted Fields check box is select. If you want to output a header record at the top of the file then check the Output Header check box. If you want to end each record line with a delimiter (the default is not to) then check the End line with delimiter check box.



�	Choose a delimiter (field separator) by choosing a delimiter from the Delimiter field. You can choose between a TAB character and a COMMA.



(	Press OK. OfficeTalk will then export the appointments to the specified CSV file.





Note:  All the appointments for the currently selected user or resource will be output.





L� XE "Appointment:Linking" �inking an Appointment� XE "Linking an Appointment" �



You can link an appointment to any other OfficeTalk data item, making it easy to quickly move between certain linked items. You can link an appointment to an item in the following way:



Œ Select the appointment that you want to link.

� Press the � button above the Daily Appointments Window.

Ž Select the other OfficeTalk data item and press the � button above that data item’s window.



The appointment will now be linked to that data item. A �EMBED PBrush \s  \* mergeformat��� symbol will appear next to the appointment. For more information on linking, see the Linking section in the chapter named General OfficeTalk Features.





Printing Your Daily Appointments� XE "Printing Your Daily Appointments" �



OfficeTalk lets you print out your daily appointments by pressing the � EMBED PBrush  ��� button above the Daily Appointments Window. When you press this button, the Print Daily Appointments dialog box will appear.
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The Print Daily Appointments dialog box



The fields and buttons in the Print Daily Appointments dialog box are described in the table below:



Field/Button�Description��From/To Fields.�The From and To date fields specify the date range that you wish to print.��New page per day.�Check this check box if you wish to start a new page for every new day printed.��Print appointment notes.�Check this check box if you wish to print any notes associated with the appointments.��Title Font�The font of the date title which is printed at the beginning of every new day.��Appointment Font�The font of the appointment description.��Note Font�The font of the notes, if printed.��

OfficeTalk provides common print functionality in all Print dialog boxes. This functionality includes:



	�SYMBOL 183 \f "Symbol" \s 12 \h�  Defining headers and footers

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Printer setup

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Preview capability



For more information on this common print functionality, see the Printing chapter in the General OfficeTalk Features section.





� XE "Weekly Appointment" �� XE "Weekly Appointments Window" �Weekly Appointments Window   �



You can view your appointments a week at a time by pressing the � button in the sub toolbar or by bringing up the popup menu with the right mouse button and selecting Weekly View. Pressing this button will change display to the Weekly Appointments Window. The Weekly Appointments Window is shown below:



� EMBED PBrush  ���



Weekly Appointments Window



Any normal appointments will be displayed in black in the Weekly Appointments Window. If an appointment is the result of scheduling a task (See Task List later on in this chapter) then the appointment will be displayed in blue. If the appointment is the result of scheduling a task and the appointment has either been marked complete or the appointment has become overdue, then the appointment will be displayed in green or red, respectively. 





A� XE "Weekly Appointment:Adding" �� XE "Adding an Appointment" �dding an Appointment



One way to add an appointment from the Weekly Appointments Window is by dragging a task from the Task List (See Task List later on in this chapter) and dropping the task on the required day. OfficeTalk will schedule the task as early in the day as possible. If you wish to specify a time for the appointment, then you will need to move and/or stretch the appointment from within the Daily Appointments Window. You can view a particular day in the Daily Appointments Window by keeping the CTRL key pressed and double clicking (using the left mouse button) on the relevant day in the Weekly Appointments Window.



Note:	Double clicking on a day in the Weekly Appointments Window will bring up the Appointments dialog box so you can create a new appointment on the selected day.



Another way to add an appointment from the Weekly Appointments Window is by pressing the � button and entering a date and time into the Appointment dialog box.



C� XE "Weekly Appointment:Changing the Week Shown" �� XE "Changing the Week Shown" �hanging the Week Shown



There are several ways of changing the date in the Weekly Appointments Window. If you change the week of the calendar then the Weekly Appointments Window will display appointments for that week. The � (Previous Week), � (This Week) and � (Next Week) buttons may also be used to change the date shown by the Weekly Appointments Window.





P� XE "Weekly Appointment:Printing" �� XE "Printing Your Weekly Appointments" �rinting Your Weekly Appointments



OfficeTalk lets you print out your weekly appointments by pressing the � EMBED PBrush  ��� button above the Weekly Appointments Window. When you press this button, the Print Weekly Appointments dialog will appear.



�



Print Weekly Appointments dialog box



 In most cases, all you will need to do in order to print out your weekly appointments is select the paper style and press the Print button. OfficeTalk lets you customise your print out by providing several check boxes, radio buttons and fields. The functionality of the Print Weekly Appointments dialog box ummarised below:

Field�Description��From/To�The From and To date fields specify the date range that you wish to print.��Wrap text�If you check the Wrap Text check box, OfficeTalk will wrap any text which would otherwise be too long to fit on a single line.��Indicate overflow�If you check the Indicate overflow check box, OfficeTalk will draw an arrow to indicate overflow when too many appointments in a single day have been drawn in the chosen font. You will need to reduce the Appointment Font size if you wish to see all of the appointments.��

You may print out weekly appointments in a variety of formats. They are as follows:



�SYMBOL 183 \f "Symbol" \s 12 \h�  Week to a page�Prints the entire week on a single page.���SYMBOL 183 \f "Symbol" \s 12 \h�  Standard week to a two pages�Prints the entire week on two pages.���SYMBOL 183 \f "Symbol" \s 12 \h�  Working week to a two pages�Prints the working week on two pages.���SYMBOL 183 \f "Symbol" \s 12 \h�  Two days to a page�Prints 2 days on each page.���SYMBOL 183 \f "Symbol" \s 12 \h�  Day to a page�Prints a single day on page.���SYMBOL 183 \f "Symbol" \s 12 \h�  Left dates�Left justifies the date text.���SYMBOL 183 \f "Symbol" \s 12 \h�  Right dates�Right justifies the date text.���SYMBOL 183 \f "Symbol" \s 12 \h�  Alternating dates�Justifies the date text alternately.���SYMBOL 183 \f "Symbol" \s 12 \h�  Start on left�Left justifies the date text and then alternates.��

When printing appointments, you can choose the following fonts:



�SYMBOL 183 \f "Symbol" \s 12 \h�  Time Font�The appointment start times font���SYMBOL 183 \f "Symbol" \s 12 \h�  Appointment Font�The appointment description font.���SYMBOL 183 \f "Symbol" \s 12 \h�  Date Font�The font of the date text in each day box.��				

OfficeTalk provides common print functionality in all Print dialog boxes. This functionality includes:



	�SYMBOL 183 \f "Symbol" \s 12 \h�  Defining headers and footers

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Printer setup

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Preview capability



For more information on this common print functionality, see the Printing section in the General OfficeTalk Features chapter.



If you preview the Weekly Appointments print out, with careful selection of fonts, OfficeTalk will display a preview output similar to that shown below:



�

		

Weekly appointments print preview� XE "Printing Your Weekly Appointments" �



� XE "Monthly Appointment" �� XE "Monthly Appointments Window" �Monthly Appointments Window   �



You can view your appointments a month at a time by pressing the � button . The Monthly Appointments Window is shown below. In most cases, appointments will be displayed in black in the Monthly Appointments Window. If an appointment is the result of a scheduled task (See Task List later on in this chapter) then the appointment will be displayed in blue. If the appointment is the result of a scheduled task and the appointment has either been marked complete or the appointment has become overdue, then the appointment will be displayed in green or red, respectively. 



� EMBED PBrush  ���



Monthly Appointments Window



A� XE "Monthly Appointment:Adding" �� XE "Adding an Appointment" �dding an Appointment



One way to add an appointment from the Monthly Appointments Window is by dragging a task from the Task List (See Task List later on in this chapter) and dropping the task on the required day. OfficeTalk will schedule the task as early in the day as possible. If you wish to specify a time for the appointment, then you will need to move and/or stretch the appointment from the Daily Appointments Window. You can view the Daily Appointments Window for a particular day by pressing the CTRL key and double clicking the mouse on the day that you wish to view. 

Another way to add an appointment is by pressing the � button to pop up an Appointment dialog box. The date and time field in the dialog box will represent the current time but you may change these fields. When you press OK, OfficeTalk will attempt to place the entry in your diary. If the new appointment clashes with any existing appointments, OfficeTalk will schedule the appointment as soon as possible after the existing appointment.



Note:	Pressing the CTRL key and double clicking on a day in the Monthly Appointments Window will view that day in the Daily Appointments Window. Double clicking without pressing the CTRL key will pop up the Appointments dialog box so that you can add an appointment to that day.

C� XE "Monthly Appointment:Changing the Month Shown" �� XE "Changing the Month Shown" �hanging the Month Shown



There are several ways of changing the date in the Monthly Appointments Window. If you change the month of the calendar then the Monthly Appointments Window will display appointments for that month. The � (Previous Month), � (This Month) and � (Next Month) buttons may also be used to change the date shown by the Monthly Appointments Window.





P� XE "Monthly Appointment:Printing" �� XE "Printing Your Monthly Appointments" �rinting Your Monthly Appointments



OfficeTalk lets you print out your monthly appointments by pressing the � EMBED PBrush  ��� button above the Monthly Appointments Window. When you press this button, the Print Monthly Appointments dialog box will appear.



�



Print Monthly Appointments dialog box



 In most cases, all you will need to do in order to print out your monthly appointments is select the paper style and press the Print button. OfficeTalk lets you customise your print out by providing several check boxes, radio buttons and fields. The functionality of the Print Monthly Appointments dialog is summarised in the table below:

�

Field�Description��From/To�The From and To date fields specify the date range that you wish to print.��Wrap text�If you check the Wrap text check box, OfficeTalk will wrap any text which would otherwise be too long to fit on a single line.��Indicate overflow�If you check the Indicate overflow check box, OfficeTalk will draw an arrow to indicate overflow when too many appointments in a single day have been drawn in the chosen font. You will need to reduce the Appointment Font size if you wish to see all of the appointments.��Print appointment times�If you check the Print appointment times check box, OfficeTalk will prefix each appointment with its time. ��Print sub calendars�If you check the Print sub calendars check box, OfficeTalk will display last months and next months calendars at the bottom of the page.��

When printing appointments, you can choose the following fonts:



�SYMBOL 183 \f "Symbol" \s 12 \h�  Time Font�The appointment start times font (relevant only if Print Appointment Times is checked).���SYMBOL 183 \f "Symbol" \s 12 \h�  Appointment Font�The appointment description font.���SYMBOL 183 \f "Symbol" \s 12 \h�  Date Font�The font of the date text in each day box.���SYMBOL 183 \f "Symbol" \s 12 \h�  Sub Calendar Font�The font used to display the sub-calendars.���SYMBOL 183 \f "Symbol" \s 12 \h�  Day Font�The font used to display the day names.��

OfficeTalk provides common print functionality in all Print dialog boxes. This functionality includes:



	�SYMBOL 183 \f "Symbol" \s 12 \h�  Defining headers and footers

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Printer setup

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Preview capability



For more information on this common print functionality, see the Printing section in the General OfficeTalk Features chapter.



If you preview the Monthly Appointments print out, with careful selection of fonts, OfficeTalk will display a preview output similar to that shown below:



�



Monthly appointments print preview

T� XE "Task" �� XE "The Task List" �he Task List



The Task List is at the bottom right corner of the Diary View. It is a to do list with a set of very powerful features to help you keep track of your workload.



� EMBED PBrush  ���



Task List



M� XE "Task:Maximising The Task List" �� XE "Maximising The Task List" �aximising The Task List



You can maximise the the Task List by pressing the � button in the top right corner of the List. When maximised the button in the top right corner of the window will change to a � button. Press this button to restore the list back to its original size.





A� XE "Task:Adding a Task" �� XE "Adding a Task" �dding a Task



You can add a task in one of three ways:



Action�Description��Clicking the mouse in the Task List.�Click the left mouse button in a blank part of the Task List (in the case of a full task list, this will be right at the bottom of the list window). An edit caret will appear. Type in the description of the task and press ENTER.��Press the � button which is above the Task List.�Press the � button. A Task dialog box will appear. Fill out the dialog box and press OK.��Press the � button in the sub toolbar.�A Task dialog box will appear. Fill out the dialog box and press OK.��

In the last two cases a Task dialog box will appear.
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Task dialog box



The Task dialog box fields are described in the table below:



Field�Description��Description�The description of the task.��Require Deadline�Check this check box to indicate that the task has a deadline. i.e. a time by which the task must be completed.��Deadline�The deadline date and time of the task.��Duration�The duration of the task. The duration that you enter is rounded to the nearest 5 minutes. This is used only when you schedule tasks.��Classification�This is a classification description which may be assigned to the task. Classification descriptions may be set up from Supervisor Mode.��Priority�This is a pull down list from which you can select one of five priorities to represent the priority of the task. Priority descriptions may be defined from within Supervisor Mode.��Complete�Check this check box to mark the task as completed.��Private�Check this check box if you do not want any other users to see the description of the task. This applies even to users who have full access to your diary.��



E� XE "Task:Editing a Task" �� XE "Editing a Task" �diting a Task



You can edit a task in one of four ways:



Action�Description��Using the � button.�Select the task that you wish to edit and press the � button. The Task dialog box will appear allowing you to modify any of the fields.��Double clicking on the task.�Double click on the task that you wish to edit. The Task dialog will appear allowing you to modify any of the fields.��Selecting the task and pressing the ENTER key.�Select the relevant task by single clicking on it using the left mouse button. Then press the ENTER key. The Task dialog box will appear allowing you to modify any of the fields.��Selecting the task and typing.�Select the relevant task by single clicking on it using the left mouse button. Next, start typing. Characters will be added to the end of the task description (unless you press the Backspace key in which case characters from the end will be deleted). A Task dialog box will not appear.��



D� XE "Task:Deleting a Task" �� XE "Deleting a Task" �eleting a Task



You can bin a task in one of two ways:



Action�Description��Using the � button.�Select the task that you wish to bin and press the � button. The task will be removed from your Task List and placed in the bin. To delete the task completely, you must pop up the Bin Contents dialog box by double clicking on the bin and then use the � button to delete the task.��Drag the task to the bin.�Drag the task that you wish to delete by pressing the left mouse button on the task and, while keeping the left mouse button depressed, move the cursor over to the bin. The cursor should change to indicate that it is dragging a task. Drop the task onto the bin by releasing the left mouse button.��

Deleting a Task



S� XE "Task:Deadline" �� XE "Deadline" �� XE "Setting a Task's Deadline" �etting a Task’s Deadline



Bring up the Task dialog box by selecting the task and pressing the � button. Check the Require Deadline check box and enter the deadline date and time into the Deadline field. If a task is not completed at the time of its deadline, OfficeTalk will pop up a message box warning you that the task has become overdue. It will then display that task in red along with an overdue symbol, �. 



�



Overdue warning





S� XE "Task:Priority" �� XE "Priority" �� XE "Setting a Task's Priority" �etting a Task’s Priority



When you create a task, it is given a default priority. This default priority is set up in Supervisor Mode. You can change the priority of a task in one of three ways:



Action�Description��Using the cursor keys on the keyboard .�Select the task whose priority you wish to change. Whilst holding down the CTRL key, press the UP or DOWN cursor keys to increase or decrease the priority, respectively.��Using the mouse.�While holding down the CTRL key, click the mouse on the priority marker. The priority of the task will increase.��Using the Task dialog box.�Select the task whose priority you wish to change and press the � button. Choose the appropriate priority from the Priority pull down list and press OK.��

The descriptions in the priority pull down list may be changed by a supervisor. For more information on customising the priority descriptions see the Workgroup Details section in the Supervisor Mode chapter.





S� XE "Task:Classification" �� XE "Classification" �� XE "Task Classification" �etting a Task’s Classification



Bring up the Task dialog box by selecting the task and pressing the � button. Select the classification description from the Type pull down list. Press OK. For information on how to supply a list of Task Classifications, see the Classifications section in the Supervisor Mode chapter.





M� XE "Task:Marking a Task as Complete" �� XE "Complete" �� XE "Marking a Task as Complete" �arking a Task as Complete



You can mark a task as complete in one of three ways:



Action�Description��Using the � smart button.�Select the task which you wish to mark as complete and press the � button.��Using the task trays.�Ensure that the Task Trays are visible by selecting Task Trays from the Options menu. Drag the task from the task list over to the Out Tray.��Using the Task dialog box.�Select the task whose priority you wish to change and press the � button. Check the Done check box and press OK.��

When you mark a task as completed, the task text is changed to green and a completed symbol, �, is attached to the task. If you want OfficeTalk to draw a line through the task when it is completed, select Lines Through Done Tasks from the Options menu.



M� XE "Task:Multi-level Tasks" �� XE "Multi-level Tasks" �ulti-level Tasks



Sometimes it is convenient to be able to break down larger tasks in to smaller, more manageable, tasks. OfficeTalk lets you do this by letting you create multi-level tasks. If you have two adjacent tasks in your task list, you can make the second task a sub-task of the first task by selecting the second task and pressing the � button, which is above the Task List. The second task will be indented and a � symbol will appear next to the first task to indicate that it has one or more sub tasks. The first task has become a parent task. If you click the � symbol, the parent task will hide its sub-task(s) and the � symbol will change to a � symbol.



You can make one or more tasks into sub tasks in several different ways. Each way is described in the table below:



Action�Description��Using the � button.�Select the task, or tasks, which you wish to make into sub tasks of the task above. Press the � button. You can restore the task back to its original level by selecting the task and pressing the � button.��Using the cursor keys on the keyboard.�Select the task, or tasks, which you wish to make into sub tasks of the task above. While keeping the CTRL key depressed, press the RIGHT cursor key. You can restore the task back to its original level by selecting the task and pressing the LEFT cursor key while keeping the CTRL key depressed.��Drag and drop.�Drag the task or tasks, which you wish to make into sub tasks, onto any task in the task list. The task that you drag onto will become the parent of the dragged task(s). Use this method when the parent task (to be) and sub task (to be) are not adjacent in the Task List. The task window will scroll while you are dragging if necessary.��

It is possible to make sub tasks of sub tasks. There is no restriction on the number of task levels. Generally, the more complex a task or activity is, the more levels you are likely to break the task down into. If you mark a parent task as complete, all of its sub tasks will be automatically marked as complete. A parent task will be automatically marked as complete only when all of its sub tasks have been completed.



A parent task will be marked as overdue if any of its sub tasks become overdue.



S� XE "Task:Scheduling a Task" �� XE "Scheduling a Task" �cheduling a Task



Sometimes, you may wish to allocate some time to do a particular task by placing a corresponding appointment in your schedule. Rather than having to manually make a new appointment with the same description as the task, OfficeTalk lets you schedule a task. When you schedule a task, OfficeTalk automatically creates an appointment in the Daily Appointments Window and associates the task with the appointment. You can schedule a task by dragging the task from the Task List and dropping it on the relevant time slot in the Daily Appointments Window. Alternatively, you may drop it on the relevant day in the Weekly or Monthly Appointments Windows. If you do the latter, OfficeTalk assumes that you want to schedule the task as early as possible on the specified day.



When you schedule a task, the task becomes blue and a � symbol is attached to the task. You can use the � button to find out when a particular task is scheduled for (See the When Utility later in this chapter).

�A� XE "Task:Adding Notes" �� XE "Task Notes" �� XE "Adding Notes to a Task" �dding Notes to a Task



You may wish to add notes to a task, for example, to detail the steps needed to complete the task. OfficeTalk lets you attach notes to any task in one of two ways:



Action�Description��Using the � button.�Select the task to which you wish to attach a note and press the button. A Notes dialog box will appear.��Via the Task dialog box.�Bring up the Task dialog box by selecting the task to which you wish to attach a note and pressing the � button. Press the Notes button in the Task dialog box. A Notes dialog box will appear.��

In both the cases described in the table above, a Notes dialog box will appear.



�



Notes dialog box



You can type any text into this box. When you have finished, press OK. If a task has some notes associated with it then the � marker will appear to the right of the task in the Task List. If you double click the left mouse button on the � marker then the corresponding notes will appear in a Notes dialog box, letting you edit the existing notes. Press OK to save the changes or press Cancel to ignore the changes.



If you schedule a task which has notes then the resulting appointment will have a � marker indicating that it too has notes. The appointment’s notes will be identical to the task’s notes. Any changes to the notes will be reflected in both the task and the appointment.

Deleting Notes from a Task� XE "Deleting Notes from a Task" �� XE "Task:Deleting Notes" �



You can delete a task’s notes by selecting the task (or tasks) whose notes you wish to delete and then selecting Delete Notes from the Edit/Task menu.



� EMBED PBrush  ���



Deleting task notes

T� XE "Task:Markers" �� XE "Task:Markers" �� XE "Task Markers" �ask Markers



There are several symbols which may be attached to a task to represent its state. These are as follows:



�	Indicates that the task has become overdue.



�	Indicates that the task is complete.



�	Indicates that the task is scheduled and is neither complete nor overdue.



The task markers are shown by default but may be hidden by selecting the Task sub menu from the View menu and then selecting the Task Markers menu item. 



By default, every task has a priority marker which indicates the task’s priority, for example, �. You can hide the priority markers by selecting the Task sub menu from the View menu and then selecting the Priority Markers menu item.



Sometimes, you may be assigned a task from an OfficeTalk project. The assigned task will have a � EMBED PBrush  ��� marker to indicate that the task has been assigned from a project. To hide project markers, select the Task sub menu from the View menu and then select the Project Markers menu item.



� EMBED PBrush  ���



Hiding task markers



If a task has notes attached to it, then the task will have a � marker. To hide notes markers, select the Task sub menu from the View menu and then select the Notes Markers menu item.



Only the link markers (�EMBED PBrush \s  \* mergeformat���) may not be hidden.

S� XE "Task:Sorting" �� XE "Task, Sorting" �� XE "Sorting Tasks" �orting Tasks



You can sort your Task List in many different ways. OfficeTalk allows you to apply a first, second and third sort on your task list. For example, you may wish to apply the following sort:



First Sort�By status��Second Sort�By priority��Third Sort�Alphabetically��

This would first sort the entire list by the status of each task (i.e. all completed tasks would be grouped together, all overdue tasks would be grouped together etc.). Then each of these groupings would be sorted by priority (i.e. there would be a sub grouping of all priority 1, overdue tasks). Finally each of these sub groupings would be sorted alphabetically.



You can sort your task list using the � button which is located in the sub toolbar. When you press this button the Sort Tasks dialog box will appear. 



�



Sort Task dialog box



You can choose your first, second and third sorts by selecting the appropriate radio buttons. You can choose whether your sort is ascending or descending by checking or un-checking the Ascending check box. When you press OK your Task List will be sorted.



Exporting Tasks� XE "Exporting Tasks" �



OfficeTalk lets you export tasks to a CSV file. You can do this in the following way:



(	Select Export/CSV Tasks from the File menu. This will pop up a CSV Output dialog box.



�



CSV Output dialog box



�	Select a filename for the output CSV file. You can do this by pressing the � button and selecting the filename from the Save As dialog box.

	

Ž	If you want each item of data to be encapsulated by quotes, then ensure that the Quoted Fields check box is select. If you want to output a header record at the top of the file then check the Output Header check box. If you want to end each record line with a delimiter (the default is not to) then check the End line with delimiter check box.



�	Choose a delimiter (field separator) by choosing a delimiter from the Delimiter field. You can choose between a TAB character and a COMMA.



(	Press OK. OfficeTalk will then export the tasks to the specified CSV file.



Note:  All the tasks for the currently selected user.



L� XE "Task:Linking" �� XE "Task, Linking" �� XE "Linking a Task" �inking a Task



You can link a task to any other OfficeTalk data item, making it easy to quickly move between certain linked items. You can link a task to an item in the following way:



Œ Select the task that you want to link

� Press the � button above the Task List

Ž Select the other OfficeTalk data item and pressing the � button above that data item’s window



The task will now be linked to that data item. A �EMBED PBrush \s  \* mergeformat��� symbol will appear next to the task. For more information on linking, see the Linking section in the chapter named General OfficeTalk Features.





P� XE "Task:Printing" �� XE "Printing The Task List" �rinting The Task List



OfficeTalk lets you print out your tasks by pressing the � EMBED PBrush  ��� button above the Task List. When you press this button, the Print Tasks dialog box will appear.



�



Print Tasks dialog box



In most cases, all you will need to do in order to print out your tasks is select the paper style and press the � button. OfficeTalk lets you customise your print out by providing several check boxes, radio buttons and fields. The functionality of the Print Tasks dialog box is summarised below:



Field�Description��Fully Expand List�If you check this box, OfficeTalk will fully expand the Task List to show any sub tasks prior to printing.��Print Notes�When this check box is checked, OfficeTalk will print the notes associated with the task directly underneath the task description in the Notes Font.��Print Field Titles�If you check this check box, OfficeTalk will print the title of each field chosen in the Title Font.��Print fields�OfficeTalk lets you select one or more of the following fields: Status, Priority, Deadline, Duration, Classification.��

When printing tasks, you can choose the following fonts:



	�SYMBOL 183 \f "Symbol" \s 12 \h�  Title Font		The font used to print the field titles	

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Task Font		The font used to print the tasks

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Sub-Task Font		The font used to print the sub-tasks

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Note Font		The font used to print the notes



OfficeTalk provides common print functionality in all Print dialog boxes. This functionality includes:



	�SYMBOL 183 \f "Symbol" \s 12 \h�  Defining headers and footers

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Printer setup

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Preview capability



For more information on this common print functionality, see the Printing section in the General OfficeTalk Features chapter.



If you preview the Task List print out, with careful selection of fonts, OfficeTalk will display a preview output similar to that shown below:



�



Tasks Print Preview





V� XE "Diary, Viewing Another User's Diary" �� XE "Viewing Another User's Diary" �iewing Another User’s Diary



The Task List and the Daily, Weekly and Monthly Appointment Windows together make up the Diary View. When you log on to OfficeTalk for the first time, you are automatically placed in the Diary View, showing your tasks and appointments. It is very easy to view another user’s diary by selecting the user’s name from the Diary pull down list.



�



Selecting another user's diary



Having selected another user’s diary, you will be restricted by the access that has been granted to you for that particular user. If you have been granted no access then that user will not be in your Diary pull down list and so you will not even be able to view that user’s diary. If you have read access then you will be able to view all of the users tasks and appointments (except for appointments marked as private), but you will not be able to edit any of the information nor will you be able to add or delete information in their diary. 



There are five different access levels. For more information on access rights see The User List section in the Supervisor Mode chapter.



If you have full access to another user, then you can work with another user’s diary as if it were your own. You may create links to other user’s tasks and appointments. These links will not be seen by other users just as you will not be able to view other users’ links. 



If you are using OfficeTalk without a mouse, you can change the Diary pull down list by selecting the Select Diary menu item from the View menu. This will set focus to the Selection list. Use the UP and DOWN cursor keys to change the selected user. 





A� XE "Annual Events" �nnual Events



OfficeTalk lets you keep a list of annual events. You can use the annual events feature to keep anything from birthdays and anniversaries to company holidays, for example. Annual events are personal and may not be seen by other users. When you add an annual event, you can specify a certain number of days fore-warning (if any) of the event. OfficeTalk will warn you by popping up a notification on the relevant day.



�



Warning of impending event



If OfficeTalk pops up a warning for an impending event, you are given two choices. You may either choose that OfficeTalk remind you again tomorrow when you log on or you may instruct OfficeTalk to remind you no more about this particular event this year.



�



Warning of event occurring today





A� XE "Adding an Annual Event" �dding an Annual Event



You can add an annual event by selecting Annual Events from the Schedule menu. 



� EMBED PBrush  ���



Accessing annual events



An Annual Events dialog box will appear. 



�



Annual Events dialog box



Press the � button. The Annual Event dialog box will then appear.



�



Annual Event dialog box



Type in the description of the new annual event, for example my birthday and enter the month and day of the event into the Month and Day fields. OfficeTalk will always remind you of the event on the day that it occurs when you log into OfficeTalk. If you want OfficeTalk to remind you in advance of the event, enter a number in the Days To Remind field, specifying the number of days fore-warning that you require. The default is 1 day. Finally, press OK.



Note:	Annual event reminders can be turned off using the Remind check box.





E� XE "Editing an Annual Event" �diting an Annual Event



From the Annual Events dialog box, select the event that you wish to edit and press the � button. The Annual Event dialog box will appear from which you can change the details of the annual event. When you have made the necessary changes, press OK.



D� XE "Deleting an Annual Event" �eleting an Annual Event



From the Annual Events dialog box, select the event that you wish to delete and press the � button. OfficeTalk will confirm that you wish to delete the annual event.



�



OfficeTalk confirmation



The event will be removed from the list in the Annual Events dialog box.



Annual events may be viewed from within Diary Mode by displaying them in the Background Activities Window. For more information on how to do this see Viewing Background Activities later in this chapter.

B� XE "Backing Up Your Diary" �acking Up Your Diary



OfficeTalk lets you backup your diary information either manually or automatically. To manually backup your diary information, select Backup from the File menu.



� EMBED PBrush  ���



Manually backing up your diary



OfficeTalk will ask you to confirm that you wish to backup your database. If you press Yes, any previous backup will be overwritten with the new backup. OfficeTalk saves your appointments, tasks and annual events.



�



Backup confirmation dialog box



You can set OfficeTalk to automatically back up your diary by selecting the General Preferences command from the Options menu. The Preferences dialog box will appear.



�



Preferences dialog box



Ensure that the Automatic Backup check box is checked and select the frequency of backup (defaults to daily) and the time during the day that the backup should be made. When you press OK the changes will take effect.





T� XE "The Task Trays" �he Task Trays



�



The Task Trays



The In Tray, Process Tray and Out Tray are graphical representations of a user’s workload at any point in time. They show how many unscheduled tasks a user has compared to the number of scheduled and completed tasks. Each top level task in a user’s Task List is represented by a piece of paper in a tray. If a top level task is not scheduled and not completed, then the piece of paper for that task will be in the In Tray. If a task is scheduled and not completed, then the piece of paper for that task will be in the Process Tray. If a task is completed, then the piece of paper for that task will be in the Out Tray. 



It is possible to see what is in a user’s In, Process or Out Tray at any time by double clicking on the relevant tray. A pop up box will appear showing the list of relevant tasks.



�



In Tray pop-up

			

The trays can be used to schedule and unschedule tasks and also to mark tasks as completed. To schedule a task, the usual way is to drag the task over to the diary window. It is possible to schedule a task by dragging it to the Process Tray. Doing this will cause OfficeTalk to schedule the task as soon as possible from the current time. To unschedule a task, drag the task over to the In Tray. This will remove it from the Process Tray (and the Appointments Window) and will add it to the In Tray. To mark a task as completed, drag the task over to the Out Tray. 



Using the menu, you can move selected tasks to and from any of the trays. For example, if you are using OfficeTalk without a mouse and you wish to schedule a task, one way to do it would be to select the task from the task list and choose To Process Tray from the Edit/Task menu.



� EMBED PBrush  ���



Moving a task to the Process Tray



By default, the trays are not displayed. To display the trays select Task Trays from the Options menu. OfficeTalk will remember your setting.



� EMBED PBrush  ���



Showing the task trays





V� XE "Viewing Background Activities" �iewing Background Activities



Background activities are planners, due tasks, annual events and holidays. OfficeTalk lets you view background activities within Diary Mode. This means that for the day, week or month shown, you have instant access to all the important background activities that affect you.



You can bring up the Background Activity dialog box by selecting Background Activities from the Schedule menu.



� EMBED PBrush  ���



Selecting the Background Activities dialog box



�



The Background Activities dialog box



The most flexible background activity is the planner. Planner bookings are created from the Planner Mode. For more information on planners, see the Planner Mode chapter. OfficeTalk lets you view planner bookings which occur on the date(s) displayed in the visible Appointments Window. If, for example, there is a Holiday planner for the members of your workgroup, you may include this planner as one of the planners to view giving yourself instant access to who is on holiday on any particular day, week or month.



You can choose which planners to view from Diary Mode by pressing the � button. A Viewed Planners dialog box will appear. 



�



Viewed Planners dialog box



Select the planner or planners which you wish to monitor from the Unselected Planners list and press the � button. Press OK. 



The Background Activities Window will be shown underneath the Appointments Window if there are any background activities to be shown. Each background activity will have a marker indicating what type of activity it is. They are as follows:



				�   Planner

				�   Annual event

				�   Holiday

				�   Due task



If the Daily Appointments Window is displayed then the Background Activities Window will show all activities for the day currently shown. If the Weekly or Monthly Appointments Windows are displayed then the activities for the week or month will be shown respectively.



� EMBED PBrush  ���



Background Activities Window





�� XE "The Where Utility" �  The Where Utility



The � button allows anybody to quickly enquire the whereabouts of other OfficeTalk users. It may be used by a receptionist, for example, who needs to know, at all times, how to contact users. The Where utility relies on the information with which it is provided. If OfficeTalk users supply the information then it is a very powerful tool.



�How To Use The Where Utility



If you are leaving your desk or the building you can let other users know where you are by pressing the � button while viewing your diary. The Away From Office dialog box will appear which allows you to enter the appropriate details.

	

�



The Away From Office dialog box



The fields of this dialog box are explained below:



Field�Description��Place�Where you are going to be��Phone�What your phone number will be��Ext.�What your phone extension number will be��Due back�When you expect to be back to the office��Other information�Any other information you wish to add��		

Once you have entered the details, press OK. OfficeTalk now gives you the option of logging out (if you are going to be away from the machine for a long period) or re-entering your password when you return. The latter case means that you remain logged on but no other user can access your data while you are out.



�



User Is Away dialog box



The same � button may be used to find out where a particular use is. To find out this information. Select the relevant user from the Diary pull down list and then press the � button. If that user is away from the office and has filled out the Away From Office dialog box as explained above, then you will be presented with a dialog box similar to that shown below:



�



Where is dialog box



If that particular user is in a meeting, OfficeTalk will tell you which meeting, where it is and when the user is expected out of the meeting.



�



User is in a meeting



If the user is logged into OfficeTalk, having not left any details about where he or she is, then OfficeTalk assumes that the user is in the office and displays an In The Office dialog box as shown below:



�



In The Office dialog box



If the user has left no details about where he or she is and is not logged into OfficeTalk, an information dialog box is displayed as shown below:



�



No Details Recorded dialog box

��� XE "The When Utility" �	The When Utility 



When a task is scheduled in the Appointments Window it can be easy to lose track of when the corresponding appointment was made for. The When utility is used to find out when a particular task is scheduled in the Appointments Window.



Select a scheduled task from the Task List. Press the � button. If the task has not been scheduled, OfficeTalk will pop up a message box.



If the task was scheduled, the Daily Appointments Window will show the day on which the task was booked and will show the appointment at the top of the Daily Appointments Window.



R� XE "Repeating Appointments" �epeating Appointments



This command is used to make repeated appointments. For example, you may wish to book a team meeting at 10am on the first Tuesday of each month, or you may wish to create an appointment to attend a project review every week on a Friday for six weeks.



To use the repeat utility, select an appointment from the Daily Appointments Window which is not the result of scheduling a task. Select Repeat Appointment from the Schedule menu. A Repeat Appointment dialog box will appear.



�



Repeat Appointment dialog box



The Repeat Appointment dialog box has three radio buttons, Daily, Weekly, and Monthly. The Daily radio button is selected initially. The daily repeat has the following operation:



Field�Description��Use Weekends�If you check this check box, the appointment will be repeated over weekends as well as week days. If this box is not checked, no appointments will occur on weekends. ��Ending�The appointment will be repeated from the day the original appointment started, every day, until the date shown in this field.��

The weekly repeat has the following operation:



Field�Description��Ending�The appointment will be repeated from the day the original appointment started, every week, until the date shown in this field.��

The monthly repeat has the following operation:



Field�Description��On Weekends�Select this radio button if you are happy that a monthly repeated appointment may fall on a weekend.��Before Weekend�Select this radio button if you require that all repeated appointments which would normally fall on a weekend are instead booked just before the weekend.��After Weekend�Select this radio button if you require that all repeated appointments which would normally fall on a weekend are instead booked just after the weekend.��nth of the month�If the original appointment occurs on, for example the 15th of a particular month then selecting this radio button will book all repeated appointments on the 15th of every month, except in the case of weekends, where you have chosen not to use weekends.��nth weekday of the month�If the original appointment occurs on, for example the 2nd Thursday of a particular month then selecting this radio button will book all repeated appointments on the 2nd Thursday of every month.��Last Day�If the original appointment occurs on the last day of a particular month then this radio button will become enabled. Selecting this radio button will repeat the appointment on the last day of every month, except in the case of weekends, where you have chosen not to use weekends.��Ending�The appointment will be repeated from the day the original appointment started, every month, until the date shown in this field.��

OfficeTalk will always try and repeat the appointment at the same time as the original appointment. If a potential appointment conflict arises, you will be warned of this and given the option to avoid the conflict via a Repeat Appointment Error dialog box.



�



Repeat Appointment Conflict



When repeating an appointment every day, you have the choice of :



 Button�Description��Book any time	�OfficeTalk will attempt to place the appointment at the earliest possible time in the day.��Skip�OfficeTalk will not attempt to place an appointment on this day.��Cancel�The entire repeat appointment operation will be cancelled.��

When repeating an appointment every week or month there are two further choices:



Button�Description��Previous day�Tries to make the appointment at the correct time on the previous day.��Next day�Tries to make the appointment at the correct time on the next day.��



V� XE "Viewing a Resource's Diary" �iewing a Resource’s Diary



OfficeTalk lets you keep diaries for an unlimited number of resources. Provided one or more resources exist, any user may view the diary for a resource by selecting it from the Diary pull down list at the top of the Diary Mode window. All the resources are grouped together at the bottom of the list. 



�



Selecting a resource's diary



When you select a resource from this list, the task list window will disappear and the Appointments Window will show the appointments for the selected resource.





Adding a New Resource� XE "Adding a New Resource" �



Only a supervisor can add a new resource. For more information on adding resources, see the Resource List section in Supervisor Mode chapter.
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